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Creating User Accounts




@l Finder File Edit View Go

About This Mac
Software Update...
App Store...

System Preferences...
Dock

Recent Items

Force Quit...

Sleep
Restart...
Shut Down...

Log Out Guest Account...

Choose System Preferences... from the Apple menu.



System Preferences

Personal

5 M & <

General Desktop & Dock Mission Language Security
Screen Saver Control & Text & Privacy

Hardware

o oW ) =

CDs & DVDs Displays

Internet & Wireless

@ @

Mail, Contacts MobileMe Bluetooth
& Calendars

System

R » & ¢ @

Spotlight

=

Print & Scan

Startup Disk

Users & Parental Date & Time Time Machine

Groups Controls

Click on Users & Groups.



® 0O Users & Groups

Login ems |

Other Users | m [ Change Password... ]

Guest User
Login, Sharing

Full name: admin

Apple ID: [ Set...

Address Book Card: |  Open... |

|| Allow user to reset password using Apple ID

QT Allow user to administer this computer
G} Login Options
+ = | R~

__|Enable parental controls | Open Parental Controls... |

@ Click the lock to make changes.

Click on the little padlock on lower left side.



System Preferences is trying to unlock Users &
Groups preferences. Type an administrator’s
name and password to allow this.

Password: ‘ ]

| Cancel | | Unlock |

Put in the admin username and password and click Unlock.



Other Users

Guest User
Login, Sharing

Users & Groups

G} Login Options

ol Bl

m | Change Password... |

Full name: admin

Apple ID: [ Set...

Address Book Card: |  Open... |

|| Allow user to reset password using Apple ID

v Allow user to administer this computer

|| Enable parental controls | Open Parental Controls... |

[ﬁ Click the lock to prevent further changes.

Click on the + sign.




O 0O Users & Groups

l < | > ] [ Show All } (Q 5

New Account: | Standard

Current User

Y admin

Admin Full Name: teacherl

Other Users
GCuest U Account name: teacherl
Login, Sh

Password: esecseee

Verify: sssesnes

Password hint:
(Recommended)

@) | Cancel | | Create User |

ﬁLoginOﬂﬂUH‘S
o= R~

__| Enable parental controls | Open Parental Controls... |

M
d Click the lock to prevent further changes.

Enter a username and password you’d like to use for this account. Normally | do all my work
in a standard account and only use the administrator account to install software or do other
administrative task. Better security this way.

Click Create Account. If you see a message onscreen about automatic login, click Keep
automatic login.



® OO0 Users & Groups

Current User
admin
Admin

Other Users

teacherl
Standard

Guest User
Login, Sharing

™ Allow guests to log in to this computer

Enable the guest user so that friends can temporarily log in to your
computer. Logging in to the guest account does not require a
password. Users cannot log in to the guest account remotely.

When a guest user logs out, all information and files in the
guest account's home folder are deleted.

|| Enable parental controls | Open Parental Controls... |

(M Allow guests to connect to shared folders

Q Login Options
b= | #-]

lf Click the lock to prevent further changes. @

Click on Guest account. Tick Allow guests to log in to this computer.

This is good for occasional users and for computer labs because everything you do will be
wiped when you log out.



® OO Users & Groups
|« | > || ShowAll |

admin Automatic loginf e G
Admin

Sl Display login wi admin
teacherl piag teacherl

Standard Cuest Account 1

Cuest User
Login, Sharing

[Y]Show the Sleep, Restart, and Shut Down buttons
.| Show Input menu in login window

@ Show password hints

(M Show fast user switching menu as | Full Name

|| Use VoiceOver in the login window

Network Account Server: | _lom

o o
[ Click the lock to prevent further changes.

Click Login Options.

From the Automatic Login popup choose either your account of the guest account.



Current User
admin
Admin

Other Users

teacherl
Standard

Cuest User
Login, Sharing

Users & Groups

Automatically log in as: [ teacherl

Password: [|

| Cancel || OK |

ﬁ

v Show the Sleep, Restart, and Shut Down buttons
|| Show Input menu in login window

@] Show password hints

VI Show fast user switching menu as | Full Name

|| Use VoiceOver in the login window

ol Bl

Network Account Server:

[ﬁ Click the lock to prevent further changes.

You’ll need to put in the password and click OK.




® OO0 Users & Groups
T T TT————————« "

ol

Current User

admin Automatic login: [ teacherl
Admin

Other Users

teacherl
Standard

Cuest User
Login, Sharing

Display login window as: () List of users
() Name and password

@Show the Sleep, Restart, and Shut Down buttons
|| Show Input menu in login window

@ Show password hints

@Show fast user switching menu as [ Full Name

|| Use VoiceOver in the login window

G} Login Options Network Account Server:

+ | = -

m Click the lock to prevent further changes.

Here, the computer is set up to log directly into the teacherl account. Restart the computer
and it should log directly into the teacherl account.



Configure Trackpad




@ Finder File Edit View Go

About This Mac
Software Update...
App Store...

System Preferences...
Dock

Recent Items

Force Quit Finder

Sleep
Restart...
Shut Down...

Log Out Guest Account...

Choose System Preferences... from the Apple menu.



Personal

General

[m—)
=)
o _

Desktop &
Screen Saver

Dock

Hardware

CDs & DVDs

S W

Displays Energy
Saver

Internet & Wireless

Mail, Contacts

@ @

MobileMe Network

& Calendars

System

b G

2

Parental
Controls

Date & Time

System Preferences

1

Language
& Text

Mission
Control

o Q@ @

Security Spotlight Universal
& Privacy Access

o= 8

Trackpad Print & Scan

Bluetooth

Time Machine Startup Disk

Choose Trackpad.



® OO0 Trackpad
T L I TTmT—

{ Point & Click PSEGl ATy

Scroll direction: natural
Content tracks finger movement

Zoom in or out
Pinch with two fingers

Smart zoom
Double-tap with two fingers

Rotate
Rotate with two fingers

| Set Up Bluetooth Trackpad... | @

Review the Scroll & Zoom settings. You may wish to change the Scroll direction.



® OO0 Trackpad

Tap to click
@ p

Tap with one finger

o Secondary click
Click or tap with two fingers v

@ Look up
Double-tap with three fingers

™ Three finger drag

Move with three fingers

Tracking Speed

5

Slow Fast

[ Set Up Bluetooth Trackpad... ] @

Click Point & Click. Change Tracking Speed to fast and make sure Tap to click is set. Tick
Three finger drag.



® OO0 Trackpad

{ Point & Click  Scroll & Zoom

o Swipe between pages
Scroll left or right with two fingers w

Swipe between full-screen apps
Swipe left or right with four fingers v

Mission Control
Swipe up with four fingers w

App Exposé
Swipe down with four fingers v

Launchpad
Pinch with thumb and three fingers

Show Desktop
Spread with thumb and three fingers

[ Set Up Bluetooth Trackpad... ] @

Click More Gestures. Tick App Expose. Close System Preferences when done by clicking the
Red button.



Mouse Basics




Click the Finder (lower left) to open a Finder window.



® OO0 All My Files

m oo 1T

FAVORITES

=l All My Files
> AirDrop

ﬁ Applications
.| Desktop About Downloads About Stacks
B Documents
() Downloads
H Movies

J7 Music

(=) Pictures

SHARED
1 MaraCapsule

DEVICES
iDisk

Double click the ‘About Downloads’ file to open it.



® OO0 '« About Downloads (1 page) — Locked

(a @ | & HAR = | [ e ) = [ElEEIRE

Downloads Stack

Welcome to Mac OS X Lion. Stacks automatically display their contents in a fan or a
grid based on the number of items in the stack. You

The Dock in Lion includes can also view the stack as a list. If you prefer one style

Stacks, whichyou canuse  SNENENGNGGG over the other, you can set the stack to always open in

The file is displayed. Notice that the application name at the top left of the screen has
changed to Preview.



SV File Edit View G
About Preview

Preferences... &8, [t!] |

Services 3

Hide Preview $H
Hide Others "\ 3H

Show All
Quit Preview 3 Q

Choose Quit Preview from the Preview menu. Notice the name at the top of the screen
changes back to Finder.



iew Go Window Help

<) @& Wed 10:42 PM Guest User

Q

FAVORITES

= o m (2=~

About Stacks

E All My Files

‘ L i 3
PDF Documents

" AirDrop
/v Applications
.. Desktop

About Stacks
! Documents

About Downloads
{} Downloads
- Movies
Music
(<) Pictures
SHARED
' MaraCa.

A

DEVICES

= iDisk

—

2 [=91]

/\ F‘"GA FLOY CE TR =—
Drag About Stacks to the Desktop. Note that All My Files always shows you all the ﬁles that
belong to you, regardless of their location in the filesystem




Open
Open With
Show Package Contents Stacks

Move to Trash

Cet Info
Compress “About Stacks”
Burn “About Stacks” to Disc...

Duplicate
Make Alias
Quick Look "About Stacks”

Copy "About Stacks”

Clean Up Selection
Show View Options

New Email With Attachment

Right-click on About Stacks to show the contextual menu



New Folder

Cet Info

Change Desktop Background...

Clean Up

Clean Up By

Sort By

Show View Options

Right-click on Desktop to change Desktop pattern.



Create New Folder

Right-click on Desktop, choose New Folder



. » . . 4 -. ..‘
....‘ *‘b'. - a’ "o .

_ . o e *0%
*  New Folder ’

Cet Info

Change Desktop Background...

Clean Up

Clean Up By

Sort By

Show View Options

Right-click on Desktop, choose New Folder.



untitled folder

You can type in the name immediately, no need to delete the existing text first.



After you type in the new name, my stuff, press Return (same place as Enter key).



Done. To change the name again press return, and repeat the process.



® OO0 (] my stuff

Date Modified Size = Kind

FAVORITES
=. All My Files
> AirDrop
ﬁ Applications

|3 Documents
() Downloads
H Movies

J7 Music

(2 Pictures

SHARED
1 MaraCa...

»

DEVICES

= iDisk

Double-click the newly created folder to open it.



FAVORITES
=! All My Files

> AirDrop
#% Applications

|3 Documents
) Downloads
E Movies

J7 Music

(2 Pictures

SHARED
= MaraCa... &

DEVICES
iDisk

Create a new folder inside it called lesson plans.



Copy Files




Rl Window Help

Back 38 |
Forward 35 |
Select Startup Disk on Desktop

=l All My Files
7 Documents 4 ¥0
4 Desktop 48D
 Downloads 8L
& Home
= Computer
@ AirDrop

@ Network &K
=l iDisk b
& Applications O 8BA

% Utilities

Recent Folders

Go to Folder...
Connect to Server...

Choose Computer from the Go menu to open a new Finder window.



FAVORITES
=. All My Files

> AirDrop

#\ Applications Macintosh HD MaraDisk Network
Desktop

|3 Documents
) Downloads
H Movies

J7 Music

(2 Pictures

SHARED
= MaraCa... &

DEVICES
iDisk

Double click on Macintosh HD to show the contents.



®00 =4 Macintosh HD

FAVORITES
=! All My Files
Q AirDrop

#% Applications Applications
.| Desktop

Iﬁ Documents
() Downloads
H Movies
J7 Music

(=) Pictures

SHARED
= MaraCa... &

DEVICES
iDisk

Click Column View.



FAVORITES — |- l [ Applications
=0 All My Files ' Library

= System
“> AirDrop MaraDisk P

Users
A Applications @ Network >
.| Desktop
B Documents

o Downloads
E Movies

Jo Music

(2) Pictures

SHARED
=3 MaraCa... &

DEVICES
iDisk

The contents of Macintosh HD are displayed in columnar format.



Applications
Library

N System
Users

| FAVORITES
= All My Files
> AirDrop
rAg Applications
.., Desktop
[3 Documents
() Downloads
E Movies
Jo Music
(2 Pictures

>

SHARED
— MaraCa...

DEVICES
iDisk

(] Desktop Pictures

(] Application Support
(] Audio

[ Caches

(] ColorPickers

(] ColorSync

(] Components

(] Compositions

(] Contextual Menu Items

" Desktop Pictures

(] Dictionaries

(] DirectoryServices
(] Documentation
(] Extensions

(] Filesystems

(] Fonts

(] Frameworks

(] Graphics

(] iChat

(] Image Capture
(] Input Methods
(] Internet Plug-Ins

[
[
[
[
[
[
[
[
>

[
[
[
[
[
[
[
[
[
[
[
[

(] Abstract

Andromeda Galaxy.jpg
Aqua Blue.jpg

& Aqgua Graphite.jpg
L Art

™ Beach.jpg

(] Black & White

=
| |
| |
=
]
-
1
1
=]
=]
=]
-
-

Bristle Grass.jpg

Classic Aqua Blue.jpg
Classic Aqua Graphite.jpg
Ducks on a Misty Pond.jpg
Eagle & Waterfall.jpg
Elephant.jpg
Flamingos.jpg

Floating Leaves.jpg

Flow 1.jpg

Flow 2.jpg

Flow 3.jpg

Forest in Mist.jpg

Grass Blades.jpg

Isles.jpg

Click Library -> Desktop Pictures.



® OO0

(] Desktop Pictures

(22| = [l om ) (2]

= v | Q

FAVORITES
= All My Files
> AirDrop

#\ Applications

Desktop

1 Documents
Downloads
Movies
Music

J Pictures

SHARED

& MaraCa... &

DEVICES
= iDisk

(2] Applications
>

(1] Library
. [3f] System

(3] Users

» [ Application Support

» [ Audio

» (@l Caches

» [ ColorPickers
(] ColorSync
(] Components
(] Compositions

(] Contextual Menu Items

# Desktop Pictures >

(] Dictionaries

(] DirectoryServices
(] Documentation
(] Extensions

(] Filesystems

] Fonts

(] Frameworks

(] Graphics

(] iChat

(] Image Capture
(] Input Methods
(] Internet Plug-Ins

- [l Art
™ Beach.jpg
- [ Black & White

- [J] Abstract

Andromeda Galaxy.jpg
Aqua Blue.jpg
Aqua Graphite.jpg

Bristle Grass.jpg

Classic Aqua Blue.jpg
Classic Aqua Graphite.jpg
Ducks on a Misty Pond.jpg
Eagle & Waterfall.jpg

- Elephant.jpg
= Flamingos.jpg

Floating Leaves.jpg
Flow 1.jpg
Flow 2.jpg

1 Flow 3.jpg

Forest in Mist.jpg
Grass Blades.jpg

Isles.jpg

Drag Desktop Pictures to the my stuff folder.



FAVORITES
= All My Files

> AirDrop

ﬁ Applications lesson plans Desktop Pictures
Desktop

|3 Documents
() Downloads
H Movies

J7 Music

(2 Pictures

SHARED
= MaraCa... &

DEVICES

= iDisk

Open my stuff.

You should see lesson plans and Desktop Pictures in there.



® OO0

FAVORITES

my stuff
| oo - 5 BRIy " Q
Date Modified Size  Kind
Jul 30, 2011 9:12 AM - Folder

=! All My Files o Desktop Pictures
> lesson plans
> AirDrop

ﬁg Applications
.| Desktop
Ij Documents

() Downloads
— Movies

J7 Music

(2 Pictures

SHARED
= MaraCa... &

DEVICES
iDisk

Today 10:45 PM

Click on List view button.

This view is most like Windows Explorer.



FAVORITES
= All My Files

Jul 30, 2011 9:12 AM
_ » [ Abstract Jul 28, 2009 1:18 PM
< AirDrop = Andromeda Galaxy.jpg Jun 14, 2011 2:40 AM
r/.\g Applications = Aqua Blue.jpg Jul 28, 2009 1:18 PM
@ Desktop & Aqua Graphite.jpg Jul 28, 2009 1:18 PM
@ Documents > G Art Jul 30, 2011 8:36 AM

Beach.jpg Jun 14, 2011 2:40 AM
() Downloads » (] Black & White Jul 28, 2009 1:18 PM

Bristle Grass.jpg Jun 14, 2011 2:40 AM
Classic Aqua Blue.jpg Jul 28, 2009 1:18 PM
Classic Aqua Graphite.jpg Jul 28, 2009 1:18 PM
Ducks on a Misty Pond.jpg Jun 14, 2011 2:40 AM
Eagle & Waterfall.jpg Jun 14, 2011 2:40 AM
Elephant.jpg Jun 14, 2011 2:40 AM
Flamingos.jpg Jun 14, 2011 2:40 AM
Floating Leaves.jpg Jun 14, 2011 2:40 AM
Flow 1.jpg Jul 28, 2009 1:18 PM
Flow 2.jpg Jul 28, 2009 1:18 PM
Flow 3.jpg Jul 28, 2009 1:18 PM

-

| m (e (e

Jo Music
(2 Pictures

SHARED
) MaraCa... &

DEVICES
iDisk

Click on the Triangle to the left of Desktop Pictures to show its contents.



® 00

e

FAVORITES
= All My Files
*;“ AirDrop
#% Applications
.| Desktop
[Bj Documents
¢ Downloads
H Movies
JJ Music
(2 Pictures
SHARED
> MaraCa... =

DEVICES
é‘ iDisk

Name
v [ ] Desktop Pictures

» [ ] Abstract

-
=

Andromeda Galaxy.jpg
Aqua Blue.jpg
Aqua Graphite.jpg

Aqua Graphite.jpg

A |

Date Modified Size
Jul 30, 2011 9:12 AM s
Jul 28, 2009 1:18 PM -
Jun 14, 2011 2:40 AM 4.2 MB
Jul 28, 2009 1:18 PM 496 KB
Jul 28, 2009 1:18 PM

ul 30, 2011 8:36 AM

Click Cover Flow View, you’ll be able to preview the pictures inside.



FAVORITES
= All My Files

Q AirDrop

ﬁc Applications lesson plans Desktop Pictures

@ Documents
() Downloads
H Movies

J7 Music

(2 Pictures

SHARED
= MaraCa... &

DEVICES
iDisk

Click icon view again.



Create New File




Click on the LaunchPad icon in the Dock.



)
\" '
£ .
. ./ “ '
7o

App Store Automator Calculator Chess

« 2 E

A2

Font Book GarageBand iCal iChat
-
@ ¢
iTunes iWeb :

&

Preview QuickTime Player Safari Stickies

»)

Dashboard Dictionary

X
a

Image Capture

System Preferences TextEdit

DVD Player

H/

¢

P —

Pages

©

Time Machine

All your appllcatlons W|II appear. Cllck TextEdit.




TextEdit launches. You’ll see a blue light under the TextEdit icon.



B Untitled

New Document

Options > Keep in Dock
Open at Login

Show All Windows Show in Finder

Hide
Quit

If you right-click on TextEdit then you will see a menu, choose Keep in Dock so that the
TextEdit icon is always in the Dock.



® OO0 Untitled

My trip to Japan

Type in a few sentences. You can try the following keyboard shortcuts.

Command-X Cut

Command-V Paste
Command-C Copy
delete Backspace

fn-delete Delete



Click on the Desktop and locate the my stuff folder.



FAVORITES
= All My Files

Q AirDrop

ﬁc Applications lesson plans Desktop Pictures
Desktop

@ Documents
() Downloads
H Movies

J7 Music

(2 Pictures

SHARED
= MaraCa... &

DEVICES
iDisk

Open the my stuff folder.



| FAVORITES
= All My Files
> AirDrop
rﬁ\g Applications
.| Desktop
IE Documents
() Downloads
H Movies
Jo Music
(2 Pictures

SHARED
=3 MaraCa... &

DEVICES
iDisk

(] Desktop Pictures

Abstract

‘ﬁ

Art

Classic Aqua

Andromeda Aqua Blue.jpg Aqua Craphite.jpg
Galaxy.jpg

Beach.jpg Black & White Bristle Grass.jpg

B = K

Classic Aqua Ducks on a Misty Eagle &
Graphite.jpg Pond.jpg Waterfall.jpg

[ =]
g

Open the Desktop Pictures folder.



8 TextEdit File Edit Format Window Help

.

® 00 Untitled

[ 9v | [ Helvetica : || Regular ol 12 Lol I-H';.I (B2 Y] a% = =) [10:2 [ i=~]

R e S e S e S B A : :
lo 12 4 6 Ig l10 112 14 le s —
My trip to Japan Desktop Pictur

]

| | | X6~ | | =

§‘

Andromeda
Galaxy.jpg

| ;

a
a
a

Beach.jpg

Classic Aqua D
Graphite.jpg

Drag a picture into the TextEdit document. This is called ‘drag-and-drop’.



Save New File

Close all windows. Choose Show View Options from the View menu.



" TextEdit Edit Format Window

New g8 N .
Open... 80
Open Recent b

Lt
s

Close

Duplicate
Export As PDF...

Attach Files... O #A
Show Properties 3P

Page Setup... {+38P
Print... gbP

Choose Save from the File menu.



VELILA - Jl l\EgUldl - JI 4 £ | v J _’w L I« TP . XJ E —_ | = =J L 4.\
J Save As: Untitled.rtfd | v | B
Where: | |1 Documents -
File Format: [ Rich Text Format with Attachments = J

| Cancel | | Save |

Change the name to lesson plan 1.



-

Click on the black triangle in the box to expand the window.



8 TextEdit File Edit Format Window Help

O 00 Untitled
[ v ;I [ Helvetica = :II; Regular = ;l' 12 l;l Iillj_?'u { B|I | U :I a

Save As: lesson plan 1 =
| < r.\.Hgg §mlllll||%v]\[}lessonplans =
FAVORITES About Stacks || Desktop Pictures "
/\ Applications = my stuff » || lesson plans 3
") Documents .
£ Downloads E:
5 Movies ‘
J7J Music
(2 Pictures
SHARED
i—1 MaraCa — <
File Format: | Rich Text Format with Attachments &
(¥ Hide extension | New Folder | | Cancel | [ Save ]

Click Column view. Choose Desktop, then click my stuff, then click lesson plans.

Click Save.



File Edit F

About TextEdit
Preferences... 3, _
Services = E
6

Hide TextEdit 3H
Hide Others "\ 3H

w i \ A/ A’
: \ ra

Quit TextEdit 3Q

Choose Quit from the TextEdit menu.



FAVORITES
= All My Files

Q AirDrop

ﬁc Applications lesson plans Desktop Pictures
Desktop

@ Documents
() Downloads
H Movies

J7 Music

(2 Pictures

SHARED
= MaraCa... &

Open the lesson plans folder.



® OO0 lesson plans

FAVORITES
=. All My Files
> AirDrop
#% Applications lesson plan 1

|3 Documents
() Downloads
H Movies
J7 Music

(=) Pictures

SHARED
1 MaraCa...

DEVICES

= iDisk

You can see the file you just saved there.



™M™

lesson plan 1 Open with TextEdit

My trip to Japan

Click on the file (don’t double click) and press space bar to preview it. This is called Quick
Look.



Arrange Files




V("8 Go Window Help

as lcons a6 1

Clean Up
Clean Up By
Sort By

v

Show View Options )

Close all windows. Choose Show View Options from the View menu.



Edit View Go Window

Desktop

File

Icon size: 64 x 64

oA ()
| [ I Tt

Crid spacing:

=3
! | [ et |

Text size: | 12

Label position:
(+) Bottom () Right

| | Show item info
@ Show icon preview

Sort by: ¥ None

Snap to Grid

Name
Date Modified
Date Created
Date Last Opened
Date Added

Size

In the Arrange by pop up menu, choose Kind. All the icons on the Desktop will arrange
themselves on the right side of the screen. You can change other parameters as well. Close
the window when done.



Find Files




3 = 4) @@ Wed 11:07 PM Guest User o8y

spotiigh: (D

Press Command-Space to enable Spotlight.



p—— 3 = «) @ Wed 11:09PM Guest Use

e P

. W— i s S ———

Spotlight lesson plal

Show All in Finder

TopHit [ lesson plan 1
Documents . lesson plan 1
Folders | ] lesson plans

Web Searches €% Search Web for “lesson pla”"
¢4 Search Wikipedia for "lesson pla”

Spotlight Preferences...

Search for lesson plan.
It will be displayed while you are typing the name.



3 = «) @& Wed 11:10PM Guest Use:

L c—— ey "t e

Spotlight my trip to japan\

Show All in Finder

Documents [® lesson plan 1

Web Searches €% Search Web for "my trip to japan™
¢4 Search Wikipedia for "my trip to japan”

Sootliaht Preferences...

If you type in the words in that document, it will display the file.
Click Show All in Finder.



® OO0 Searching “This Mac”

oo
oo
=1
=1
=
|
4
L
4

ZUEEE Q my trip to japan Q

FAVORITES Search: All My Files Shared
= All My Files
> AirDrop
A Applications RTFD

] Desktop

B Documents
) Downloads
E Movies

Jo Music

(2 Pictures

SHARED
=3 MaraCa... &

DEVICES
iDisk

/N Guest + (1] Desktop + | my stuff » [ lesson plans ~ _ lesson plan 1

Click the file to show it’s path. Close the search window when done.



Copy to thumbdrive




=] Pictures

SHARED

3 MaraCa... &
DEVICES

.; iDisk

__ KINGY =

Plug in your thumbdrive. Open the lesson plans folder. Your thumbdrive will appear in the
lower left corner of the window.



|

L] lesson plans

00 ml| | X ~v| | v

FAVORITES
@ AirDrop

Desktop

B Movies
J7J Music
Pictures

SHARED

DEVICES
/= iDisk
| KINGY

3 MaraCa...

=1 All My Files
r/.\; Applications

@ Documents
) Downloads

»

»

RTFD

lesson plan 1

Drag lesson plan 1 into your thumbdrive.




FAVORITES

e N\
= All My Files ==

> AirDrop == &
9@‘! Applications About Downloads apple in education ipad

|3 Documents
e il B i i
E Movies

J7 Music mobile learning simple ilife guide simple iwork guide  simple mac guide why you'll lo
mac
(2) Pictures

3 MaraCa...
RTFD

DEVICES WindowsSupport lesson plan 1
iDisk

Click on your thumbdrive. You can see the file inside.



DEVICES Y

:
-

L:_ig iDisk

To safely remove the thumbdrive, click the Eject button, then pull out the thumbdrive.



Delete files




® OO0 lesson plans

FAVORITES
=. All My Files
> AirDrop
#% Applications lesson plan 1

|3 Documents
() Downloads
H Movies
J7 Music

(=) Pictures

SHARED
1 MaraCa...

DEVICES

= iDisk

Open the lesson plans folder.



Drag lesson plan 1 to the Trash.



Fi Edit View
About Finder

- Preferences... 3. |
. 1'
—  Empty Trash... ¥ -
FAj Secure Empty Trash...
E , -
q Services b T
o/ Hide Finder 38 H b
[-3 Hide Others \3H 3§
1 Show All

Choose Empty Trash from the Finder menu.



FAVORITES
= All My Files
> AirDrop
#% Applications
] Desktop lesson plan 1
@ Documents
() Downloads

Jo Music
(2 Pictures

SHARED
) MaraCa... &

DEVICES
iDisk

If you put things into the Trash by accident, click Trash in the dock and drag it back out.



Install Printer




® 00 Software & Firmware Downloads | Samsung Product Support & Service Center e’
|‘ 4 » | + Qhttp://www.samsung.com/us/support/downIoads/color—laser—printers/CLP-S10N ¢ lQ samsung clp 510 mac &
&2 [0 =3 Apple Yahoo! Google Maps YouTube Wikipedia News (10)v Popularv

Find your product to get the latest drivers, manuals, firmware and software.

Category Sub-Category Model Name Model Code

Printers Color Laser Printers v CLP-510N

Download Center for CLP-510N

Manuals Driver Software
ceeAll-ee v
0Ss ReleaseDate Description Size (MB) Language File
MacOS 10.3~10.5 Oct 7, 2009 Print Driver (Driver) (ver.1.07 0.83 MULTI LANGUAGE e
Mac OS 10.6 Oct 6, 2009 Print Driver (Driver) (ver.3.00 3.86 MULTI LANGUAGE 3
Win Print Driver,(Add Printer) (Driver)
2000/XP/2003/NVista/2008WIinOct 31, 2008 . e d 12.83 MULTI LANGUAGE F
7 (ver.3.04.25) =
Win Universal Print Driver (Driver
2000/XP/2003/Vista/2008/WinApr 2, 2010 e s i oy e 20.66 MULTILANGUAGE @)

(ver.2.02.05.00:25)

7{32.64bit‘| _

The Mac can autodetect most printers, but if your printer doesn’t work you will need to
download the driver from the Internet first.



10 mac | Q&J
W .

Downloads

T

print_driver_for_10.6.zip

‘E-.

S0t 3.9 MB (4.8 KB/sec) — 13 minutes remaining

Wait for the download to complete.



Open in Finder‘ @ |

Click Downloads in the Dock, you will see the printer driver there. Click it.



“Installer for 10.6" is an application downloaded
from the Internet. Are you sure you want to open
it?

WebProcess downloaded this file today at 11:21 PM from

org.downloadcenter.samsung.com.

| Show Web Page | | Cancel | | Open |

Click Open.



Installer for 10.6 wants to make changes. Type
an administrator's name and password to
allow this.

Name: admin

Password:

| Cancel | | OK |

Type in your admin username and password, and click OK.



Introduction

@ Introduction

® Installation Type
@ Installing

® Finish Up

SAMSUNG DIGITal)

everyone's invited.

Installation powered by VISE X

. Go Back

Click Continue.



| Easy Install

O Introduction Samsung Printer Driver
® Installation Type

@ Installing
® Finish Up

SAMSUNG Software

) Installation
SAMSUNG DIGITalD

everyone's invited.

Disk space available: > 4CB Approximate disk space needed: 10.91MB

| GoBack | [ Install |

Click Install.



Installing

@ Introduction

© Installation Type
@ Installing

® Finish Up

Iltems remaining to be installed: 545

Installing: Easy install

SAMSUNG Software

/ﬂ Installation
SAMSUNG DIGITa!

everyone's invited.

Installation powered by VISE X

[ Stop

Wait until installation completes.



Finish Up

© Introduction Installation was successful. If you are finished, click Quit to leave
® Installation Type the Installer. If you wish to perform additional installations, click
Continue.

O Installing
® Finish Up

SAMSUNG Software

/ﬂ Installation
SAMSUNG DIGITa!

everyone's invited.

Installation powered by VISE X

[ Continue ] | Quit |

Click Quit.



Print file




About Stacks

Open the file you want to print.



W Edit View GCo Tools Bookmarks

New from Clipboard $N sou
Open... 380

1 Open Recent S
Close Window $EW
Close Selected PDF Document {38W
Save... 38 S
Duplicate
Export...

Revert to Saved...

Mail Selected PDF Document
Enter Password...

Import from Camera...

Import from Scanner e
Take Screen Shot e
Print... g6 P

Choose Print from the File menu.
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Copies

Print & Scan Preferences...

Pages: | Al v

Printet v A No Printer Selected

If you see No Printer Selected click Add Printer...

You'll need the administrator username and password to Add Printer.



Add Printer

Samsung CLP-510

Name:

Samsung CLP-510-2

Location:

macbook pro

Print Using:

-

Samsung CLP-510

Choose the printer and click Add.
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Printer: | © Samsung CLP-510

Copies: |1 @ || Two-Sided
pages
Documents Stack
= —
B - .
C f
ok _ai
- a =

PDF v] Show Details Cancel ] m

Documentvv-m-m—

Welcome to Mac OS X Lion. Stacks automatically display their contents in a fan or a

grid based on the number of items in the stack. You
The Dock in Lion includes L can also view the stack as a list. If you prefer one style
Stacks, which you can use § T over the other, you can set the stack to always open in
to quickly access frequently | e~ | that style.

used files. e
S .‘ Stacks intelligently show the most relevant items first,

Click Show Details to see advanced print options.
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%) About Stacks (1 page) — Locked

Printer: [ © Samsung CLP-510 3]
Presets: | Default Settings s
Copies: ' 1 || Two-Sided
Pages: (*) All
() From: 1 L to: |1 |

Paper Size: | A4 : | 210 by 207 mm

Orientation: M

Il

[ . )|
Preview A
! ! = L J
SAuto Rotate
() Scale: 93 %
(e | <« ] 1lofl [ » | »hi] (#)Scale to Fit: (®)Print Entire Image
(_JFill Entire Paper
Copies per page: [ 1 :]
ﬁ
(2) [ POF +| | Hide Details | | Cancel | [ Print |

Documents Stack

Welcome to Mac OS X Lion.

The Dock in Lion includes
Stacks, which you can use d
to quickly access frequently |
used files.

e
Mexico Vacation 2o [

Stacks are simple to create. Szsmromim
Just draa anv folder to the

Stacks automatically display their contents in a fan or a
grid based on the number of items in the stack. You
can also view the stack as a list. If you prefer one style
over the other, you can set the stack to always open in
that style.

Stacks intelligently show the most relevant items first,
or you can set the sort order so that the items you care

ahout most alwave annear at the tan of the stack

Click Print.



When printing starts you will see the Print Queue in the Dock. Click it.



® OO0 &= Samsung CLP-510

Printer Ready

Completed

This shows you printer status and jobs waiting to be printed.



